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TERMS AND CONDITIONS

The following terms and conditions constitute the agreement between Elsevier Science B.V. ("Elsevier") and the
individua ("the User") authorised by Elsevier to have accessto, SMART.

LICENSE

Elsevier hereby grants the User a non-exclusive, non-transferable personal license to access and use SMART for
individual submission of research papers to Brain Research and Sections (Brain Research Reviews, Molecular Brain
Research, Developmental Brain Research, Cognitive Brain Research and Brain Research Protocols). The User is
permitted to: (i) download SMART to electronic memory for subsequent single access and use by the User; and (ii)
submit research papersto Brain Research or its Sections using SMART.

The User may use SMART only in accordance with the terms and conditions of this agreement. The User must not
permit others to: (i) reproduce, transmit, disseminate or otherwise make available SMART or any part of it to any
third party whether in return for a fee or otherwise by any means (whether electronic or otherwise); (ii) delete or
obscure Elsevier's copyright notices (including notices as to any other intellectual property rights) from SMART.

COPYRIGHT

No rights of ownership, copyright or any other intellectual property rights relating to SMART (including but not
limited to its structure and lay-out) or to any other material contained in it are transferred to the User by this
agreement. Whenever any part of SMART is printed out by the User, the first sheet printed out will contain
Elsevier's copyright notices.

Subscription fees and any other sums specified in or relating to this agreement are exclusive of value added tax (or
any successor tax or equivaent local tax), which will be added and shall be payable in accordance with the law
applicable from time to time against receipt of an appropriate invoice.

WARRANTIES AND INDEMNITY

WARRANTY LIMITATIONS: (i) SMART is provided on an "AS IS" basis, without warranties of any kind, either
express of implied, including, but not limited to warranties of title, or implied warranties of merchantability of
fitness for a particular purpose; (ii) use of SMART is at your own risk; (iii) access to SMART may be interrupted
and may not be error free; and (iv) neither SMART nor Elsevier, involved in creating, producing or delivering
SMART, ot the materials contained therein, shall be liable for any direct, indirect, incidental, special, consequential
or punitive damages arising out of the use of, or the inability to use SMART.

The User shall indemnify Elsevier against any costs, damages, claims, expenses (including reasonable legal fees) or
other liabilities incurred by Elsevier in connection with any claim made against Elsevier by any third party arising
from negligence of or any breach of this agreement by the User. Elsevier reserves the right, at its discretion, to issue
an amended or modified version of SMART, or to require the deletion of any part of SMART, which might in
Elsevier's opinion be the subject of aclaim by any third party.

GENERAL

This agreement represents the entire agreement between the parties in relation to its subject matter and supersedes
all previous agreements, whether written or oral. No delay in exercising or non-exercise by either party of any of its
rights under or in connection with this agreement shall operate as awaiver or release of these rights.

If any part of any provision of this agreement is invalid or unenforceable, then the remainder of such provision and
all other provisions of this agreement shall remain valid and enforceable. This agreement shall be governed by and
construed in accordance with the laws of the Netherlands. Any dispute arising in connection with this agreement, or
the breach thereof, shall, in the absence of an amicable solution by the parties, belong to the exclusive jurisdiction of
the competent courtsin Amsterdam, the Netherlands.
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Welcometo Synapse

Welcometo SMART

SMART (System for Manuscript Authoring and Review Technology) is a
collection of programs supporting the submission of peer-reviewed science
manuscripts through the review cycle. SMART uses the Internet as the
connecting network among all users. The basic submit/review/edit cycle
is not affected. Manuscripts are still written in the same manner as before
and review is till done on a peer review basis. However, manuscripts are
electronically sent to both journal Editors and Reviewers, reducing the

time-to-review, time-to-publish, and time-to-read periods.

SMART has four basic software applications.

Submitter - Authors use this to assemble manuscripts and to transmit
them to the SMART server over the Internet. Submitter also checks the

status of the review cycle.

Reviewer - Reviewers use this to retrieve manuscripts from the SMART
server and, to enter comments, evaluations, and scores, and to transmit
them back to the SMART server.

Editor - Editors and staff members of the journals use this to log into the
server and to retrieve new manuscript submissions, assign Reviewers, send
notifications to Reviewers, see Reviewers evaluations, and to take fina

actions of manuscripts.

Server - thisinteracts with all other SMART applications to receive, send,
hold, and analyze al information flow (manuscripts, data, EMail).
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Before You Begin

This chapter deals with topics that you should be aware of before using
SMART for thefirst time.

» Package Contents

» Hardware and Software Requirements
* Installing the Software

* About this Manual

* How to use this Manual

* Technical Support
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Package Contents

If you recelved the SMART software package directly, it contains the
following:

* This manual
* Installation disks
* One SMART registration card

If you received SMART from the Internet electronically, you have one
installation file. Refer to the section on Installing the Software to

continue.
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Hardwar e and Softwar e Requirements
Macintosh
* A Macintosh IIfx or later, with a hard drive and 10 MB free for
complete installation. A 68030 minimum processor is
recommended
» System 7.1 or later
* 5 MB minimum available RAM
Power Macintosh
» Hard drive and 15 MBytes free for complete installation

» System 7.1 or later

* 15 MB of available RAM
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Installing the Software

Installations disks- if you haveinstallations disks, follow theseinstructions
to install SMART:

1.Turn on your Macintosh if it isnot already on

2. Quit any applications that are active

3. Insert Installer Disk 1 into any floppy drive

4. Double-click Install M eto begin the installation process
5. Follow the prompts on your screen

6. Eject the Installer Disk 1 and store all disks in a safe place

Network download - If you have an installation file from the Internet,
follow these instructions to install SMART:

1. Turn on your Macintosh if it is not already on
2. Quit any applications that are active
3. Double-click Install Meto begin the installation process

4. Follow the prompts on your screen

The installation process creates a SMART folder containing al of the
foldersand filesof SMART, including the Reviewer application and creates
a Preferences folder in the System Folder: Preferences:SMART folder.

Several files are copied to the Extensions folder
AOS PowerPlug

AOS Runtime
GNU RegEXx (fat)
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WASTE (fat)

Several files are aso copied to the Extensions folder depending on the

Macintosh mode!:
ANSI CCFMB8K Lib.....ccoooiiieiiiee, (For 68K machines)
ANSI CPPC LD (For PPC machines)

To Register Your Copy of the Software

Registering your copy of SMART is important. By registering, you get
free Technical Support (see the section on Technical Support) and you
will be notified of al improvements and upgrades to the software
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About thisManual

This manual provides both instructional and reference material to help you
get the most from using SMART. The manual consists of:

e QuickStart

» The Basics

* The SMART Document
» Writing a Review

» Appendixes

QuickStart should be read if you installed the software, are familiar with
M acintosh applications, and want to begin using the applicationimmediately

The Basics contains information on initial files created, user interface
issues, and network communications

The SMART Document introduces you to the Reviewer document, what
it contains, and how to maintain it

Writing a Review goes over the steps you need to know to review
manuscripts and send them to the server

Appendices has al of the appendices mentioned in the other sections,
such as certified word processors, optimizing memory, networking issues,
commercia and software utilitiesthat make using SMART software perform
better, and an expanded list of themes.
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Conventions used in this manual

Whenever special attention is required for a topic, the Alert graphic is
displayed. Pay specia attention to thisinformation asit isimportant.

Whenever there is a good tip useful to remember, the Tip graphic is
displayed.

Whenever there is emphasis required on a certain point, the By The Way
graphic is displayed.
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How to usethis M anual

This manual assumesthat you are familiar with basic Macintosh operations,
such as pressing and dragging the mouse; selecting, copying, and moving
icons of files and folders; choosing commands from pull-down and pop-up
menus; pressing on buttons to activate commands, opening and closing
documents, launching applications, managing windows and their scrollbars,
title bars, close box, and zoom box; and using the Finder. If you are not
familiar with these terms and operations, read your Macintosh User’s
Guide to learn more about your Macintosh.
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Technical Support

We have worked hard to make sure that the software and the manual are
easy to use. Should you have any difficulty, please follow the instructions
below.

We support SMART users via EMail. If you are having difficulties and

cannot find the answers in these manuals, please EMail us a note.

Before Calling for Help

1. Make sure that your computer is properly set up, and that all
cable connections are secure.

2. Make sure that you have properly installed the software according
to the instalation instructions in these manuals. All software
extensionsinstalled have no known conflictswith other extensions.

3. Be sure that you have sufficient memory (RAM), especidly if
you are running on a PowerMac.

4. Be sure that you are correctly configured to access the Internet
via TCP/IP. Contact your Network Administrator if you suspect

aproblem.

5. If you suspect a hardware problems or a problem with your
system software, contact your local Apple deal.

EMailing for Help
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SMART support is currently limited to EMail. You will receive a prompt
answer viaEMail. Pleaseinclude your Macintosh model name and number,
the version of SMART, and a brief description of the problem.

EMall to:

SMART @scripps.edu

Please put the word Tech Support in the subject heading.
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Chapter 1
Quickstart

Read this chapter if you are familiar with Macintosh applications and want
to use SMART right away. This section assumes that you have already
installed SMART.

1. Double-click Reviewer tolaunchtheapplication. A new document

window opens.

2. Select Configure... from the File Menu to enter in the SMART
server |P address.

3. Retrieve the manuscript by pressing on the Retrieve button in
the document window. Enter inyour Reviewer |D, the manuscript
ID, and the manuscript password.

4. Read the manuscript from the downloaded files.

5. Press the Review button in the manuscript window and enter in

your review.

6. Press Send Review button to send the completed review.



Chapter 2

Chapter 2
TheBasics

This chapter contains information on initia files created, user interface
issues, and network communications.

* Launching for the First Time
* User Interface

* Configuration
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L aunching for the First Time

Double-click on Reviewer to launch the application. When Reviewer
launches for the first time, a folder named SMART is created in your
Preferences folder (Figure2.1). In this folder is an additional folder
named for the Port number assigned to the SMART client. This number
isgeneraly 7000. Finally, inside thisfolder is and additional folder named
Client Patches and a file named Client Preferences. Client Patches
holds software patches supplied in the future. Client Preferences contains

the data on user preferences.

FI=———— VWl =——————15
2 items 198 ME in disk 1.8 GEB available
B i
FREF
Client Patche: Client Preferences
]
] B

Figure2.1
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User Interface

The user interface experience is similar to other Macintosh programs.

Windows are used to convey most of the information to and from SMART.

There is a single window, called the document window containing all of

the manuscripts and reviews that you are using within SMART.

Some fields in windows may be multi-columned (Figure 2.2). The width

+

of the columns can be adjusted by positioning the cursor on a vertical line

Column Cursor of acolumn. The cursor changes to acolumn cursor. While pressing the

mouse button down, drag the mouse from left to right to resize the column.
Any columns to the right of the vertical line being adjusted shifts left and
right by the same amount. To adjust only theimmediately adjacent columns

of the vertical line, hold down the Control key when moving the mouse.

=0

The cytoarchitectonics of the Nucleus Ambiquus in the rat

LE

Title

Column Titles

Authors

The cytoarchitectonics of the Nucleus Arnbiguus in the rat

Corresponding Authar

Last

First

Piddle

Institute [ [poe John .

Columns —|

.
Edwards

John
Tharnaz
Rohert

E.
LR
G

Column Cursor

Journal W I BRAIN RESE ARCH INTERACTIVE |

University ... Notification W | EMail |

Rezeatch In...

Medizal Coll... Format W I Research Report |
K%

Theme W I Spinal cord and brrainstem : anatomy |

Inztitute :
Address:

o Cornmentary

@ Manuscript O Abztract o Body O Legends O References o Keywords O Rewiew

Phane : Epail:

[_sena fevew | ]
< |3

Figure 2.2
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Tip: Hold down the Control key when adjusting the column to adjust

only the current columns touching the vertical line.

Many windows are also sensitive to drag and drop. If you select certain
data or lines of text, and then drag this to another window, or to the
Macintosh Finder desktop, data are copied, transferred, or exported.
Likewise, some windows may have files dragged into them. See later

chapters for more specific information on the capabilities of each window.

Alert: Drag and Drop must be supported in those applications.

Figure 2.3 shows the text of the comment being dragged from the review
window to the desktop, creating atext clipping file.
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EN The cytoarchitectonics of the Nucleus Ambiguus in the rat

Instructions: Enter in the review here. Tupe it or cut and paste in comments from another document.
’W‘ Acceptable in present form

’m Fresent form satisfactory

[ Priority _w ] High

Confidential Cornments

E
"l

Ic>

None

Referee Comments
Thiz is a well written report on...

o] 4l

4l

o Manuscript O Abstract ody o Legends o References o Keywords @ Rewiew

O Cornmentary

Coare I g

Drag and drop with mouse

tenct clipping
Figure 2.3

Many of the fields of windows also accept fully styled text. To change the
text directly in afield, select Text Tool from the Edit Menu to open the

Text Tool Window (Figure 2.4)

= mﬁnurier m 12 pt
Bl /[@[ulclels[k[H[w]d] DI m—

Figure 2.4

To change text:

1. Select the text to be changed using the mouse
2. Press on the various controlsin the Text Tool Window to
ater the font, the style, the size, or the color
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Configuration

SMART must be configured with the server | P address. Select Configure...
in the File menu to enter in the address. A window opens asking for the

IP address of the server (Figure 2.5).

IP address for server connection’?

|1 11.222 333 444

Figure 2.5

Using the keyboard, type in the address assigned to the server and then
press Accept. This can be in the form of a dot IP address notation as
shown in Figure 2.5 or as the physical name of the machine as shown in
Figure 2.6. Press Cancdl to close the window without storing the address.

|P address for server connection?

Isunapse.elsevier.com

Figure 2.6

The last used IP address is displayed as the default address. If SMART
was just installed, a pre-configured address is displayed. If the address is

correct, ssimply press Accept.
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Alert: See the separate note for the current IP address and name of the
SMART server that you should use for configuration.

You only need to configure this information once. Reconfiguration is
required if one of the following conditions occur:

* The preference file is deleted or becomes corrupted

* The address of the server changes

* You reinstall a new version of the operating system that may
create a new system Preference folder
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Chapter 3
The SMART Document

This chapter will show you how to use SMART to retrieve manuscript
objectsand store them in SMART documents.

* Creating a New Document

* Opening an Existing Document

* Saving a Document

* Password Protecting a Document

= By The Way: Theterm OBJECT is used repeatedly throughout this manual
and refers primarily to a database record. The database itself consists of
two primary tables - manuscripts and people. Therefore, the two primary
kinds of objects aremanuscript objects and people obj ects.

A manuscript object is a group of data describing a manuscript. The
Author enters information and attaches disk files containing the actua
content of the manuscript. Other word processing or graphics programs
were used to prepare these files.

A SMART document is file-based and contains the manuscript objects.
One document may contain any number of manuscripts reviewed from any
number of journals. Documents may be protected with passwords and are
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portable to other computers running SMART

A document window is a Macintosh window displaying al of the
manuscripts in the SMART document.
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Creating a New Document

Password

Quit

New Document %N
Open Document... #0

A document needs to be opened before working with any objects. A new
document automatically opens when starting SMART. Thereafter, other
new documents can be opened manually. Multiple documents can also be
opened simultaneously.

Select New Document in the File Menu to create a new document. The

save Document 55 keyboard equivalent of Command-N can also be entered from the keyboard
i This menu item is always enabled. A new Document Wndow named
Configure... K

Untitled opens (Figure 3.1).

#0

EiVV———"0r —————— llitledl ——"———————1=
REVIEWER

SMART - System for Manuscript Authoring and Beview Technology
Elsevier Scientific ML, The Netherlands
Copyright ® 1996, All Rights Reserved

Function Buttons ELSEVIER = m &)
S C I EN CE h%e Dépen De %‘

anuscripts
I Title Authors Journal Review |-{}
List of manuscripts
Message Field
Progress Bar——— -
g &I Messages : [=|

Figure 3.1
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= By The Way: Only the New button is normally enabled, since there are
currently no selected manuscripts. All other buttons were enabled for

illustration purposes only.

This is an empty document window. No manuscripts reviews have been
sent to SMART. Most of the functions maintaining the manuscript objects

are controlled from the Function Buttons near the top.

* Retrieve - retrieves amanuscript object and opensin amanuscript

! window. This button is always enabled.

Fetrieve

* Open - opens an existing manuscript object into a manuscript
window whose name is the same as the file document. This

Open
button is always enabled.

* Delete - deletes an existing manuscript object from the document.
This button is enabled only when a manuscript is selected.

[elete

» Check - checks a manuscript object. The SMART server returns
areport on the manuscript. The extent of the message, if any, is

I:h-;ck
determined by the editors.

* Print - prints an existing manuscript object. Only information
related to the manuscript and not its contents is printed. This
button is enabled only when a manuscript is sel ected.

Frint
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Only one manuscript may be selected in the List of Manuscripts
(Figure 3.2). To select a manuscript, press once anywhere on the line in
thelist. Columns display specific information about each manuscript.

Manuscripts
ICx Title Authors Journa 1 Review

|

2 The cytoearchitectonies o... : Doe,Jshn E. ERAIN RESEARCH Mot Sent

Figure 3.2

*| D - thisisauniqueidentification number assigned to the manuscript
when the manuscript was submitted. .This ID is used for all

communications regarding the manuscript.

* Title - thisisthe title of this manuscript. Thetitle also appearsin
the titlebars of the opened manuscript windows.

» Authors - these are all of the Authors, listed from first Author to
last Author.

 Journal - thisisthe journal of the manuscript.
* Review - thisis the review status of the manuscript. If no review

has been sent, Not Sent is displayed. Otherwise, time and date
information of submission is displayed.

The Progress Bar moves when communicating with the server, or when
some important function occurs. The M essage Field displays information
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relevant to the progress.
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Opening an Existing Document

Documents saved to disk files can be reopened. Select Open Document...

Save Document 5 in the File M enu to open an existing document on a mounted disk volume.
e The keyboard equivalent of Command-O can also be entered from the
pasaord keyboard. Thismenuitemisalwaysenabled. A filedialog opens(Figure 3.3)
Quit

to select the file document.

=Work
[ T
Desktop

| I Open I

e

Open which document?

Figure 3.3

Only SMART file documents are displayed. When Open is pressed, a

document window named My Reviews opens (Figure 3.4)

f—"—————— My Reviews =—————— |

REVIEWER

SMART - System for Manuscript Authoring and Review Technolagy
Elsevier Scigntific ML, The Netherlands

Copyright ® 1996, All Rights Peserved

¥ T

e Y .
= = = | -
ELSEVIER| [ B |[ &2 27 || &
S C I E N C E. Fetrieve Open Delete Check Print
anuscripts
. I Title Authors Journal Review H}
One M ANUSCI1 pt #8961  : The cytoarchitectonics o... | Doe,Jdohn E., Edwards,Th... |BRAIN RESEARCH IN... fMNot Sent
-+
] Messages: [&|

Figure 3.4
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This window reflects the file document. This document contains one
manuscript review not been yet sent to Brain Research. The title of the

manuscript is The Cytoar chitectonics of the Nucleus Ambiguus in theRat.
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Saving a Document

New Document %N
Open Document... 3#0
Save Document %S

Page Setup...
Print... P

Configure... K
Password

Quit #0

An modified document which has not yet been saved to disk, either opened
from afile or new, displays with a bullet character « before the title of the
window (Figure 3.5).

Saved Document —
Unsaved Document —

My Reviews

sMYy Reviews

Figure 3.5

Select Save Document in the File Menu to save an opened document to
the disk volume. The keyboard equivalent of Command-S can also be
entered from the keyboard. This menu item is enabled only when the
document window is the active window, and if the document is modified.

If the window is closed and the document has been modified, an alert
opens asking to save the document. If the document is opened from an
existing file, the document is saved to that file, and the bullet ¢ character is
removed from the window titlebar. If the document is new, afile dialog
opens (Figure 3.6) for the name of the document and location of storage.

= tork
&
|
£

Save document to what file?

Untitled |

Figure 3.6
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The default name isUntitled. Press Save to save the document to disk, or
press Cancel to abort the operation and not save the document.
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Passwor d Protecting a Document

New Document N
Open Document... &0
Save Document %S

Page Setup...
Print... ®P

Configure... GRK
Password

Quit ®0

Second field appears in which you o Pesed EEE e
type the same password again Enter Agan |
hocept

Enter the password in this
window for the first time

Any document may be protected with apassword. Thepasswordisrequested
twice when opening a document. To assign a password to a document,
select Password... in the File Menu. This menu item is enabled only
when a document window is the active window. A window opens asking
you to enter in the password twice (Figure 3.7).

=——— Change Password

=

3

£
izl }
5 H
4 b
2 z
d o

E

e
F

coept |

i

Change Passwaord

i

Change Passwaord

Click on Accept to New Password [sesese
install the password Enter Agai [sesese
hosapt
Figure 3.7

PressAccept to accept the passwords. A message window opensindicating
that the password hasbeen changed Figure 3.8. The password ispermanently
stored when the document is next saved.
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Password changed for this document. This
will not take place permanently until you
save the document at least once,

Figure 3.8

Opening a protected document asks for the password (Figure 3.9).

This document is password protected

Paszword |

Cancel I fcept

Figure 3.9

Alert: The password is CASE SENSITIVE. If you forget the password,
& you cannot gain access to the contents of the document. Contact Technical
Support if that happens.
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Chapter 4
Writing a Review

In this chapter you will go through all the steps needed to complete a
review of a manuscript.

* Getting Notification that Y ou are a Reviewer
* Retrieving the Manuscript

* Reading the Manuscript

* Writing the Review

» Opening a Manuscript

* Deleting a Manuscript

* Printing a Manuscript

* Sending the Review
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Getting Notification that You are a Reviewer

When the Editor of the journal requests that you review a manuscript or
write a commentary, you receive notification based on the method that is
recorded with your personal preference information. For example, if you
preferred EMail, you would receive an EMail indicating that a manuscript
from ajournal is available for your review. An example of this EMalil is
shown inFigure 4.1.

A new manuscript is ready for your review. Please save the reviewer
ID, your manuscript ID, and the manuscript password. You will need
these in order to download the manuscript.

Manuscript ID: 1001
Submission Date: 12/27/96 11:46PM
Title: The cytoarchitectonics of the Nucleus Ambiguus

in the rat.

Journal: Brain Research Interactive

Theme: Spinal Cord and Brainstem: anatomy
Keywords: Cytoarchitecture, Brainstem, Circuit
First author: Doe, John, E.

Corresponding author: Doe, John, E.

CoAuthors: Edwards, Thomas, A., White, Robert G.

Reviewer ID
Manuscript password: ArterialBlood

1011

Figure4.1

The manuscript ID and password are used to retrieve the manuscript. |If
you lose this information, you have to contact the journal Editor to get a

new password.
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Retrieving the Manuscript

i

MNewr

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

SMART retrieves the manuscript object and the attached files over the
Internet from the SMART server and opens aManuscript Window. The
attached files opens with the software application that created it. The
review is written in the manuscript window and sent back to the SMART

Server.

Press on the Retrieve Button in the document window or select Retrieve
Manuscript in the Manuscripts Menu. A window opens and requests
certain information in order to retrieve the manuscript (Figure 4.2).

Login

Figure 4.2

The Reviewer ID isyour assigned ID. The Manuscript ID is unique to the
manuscript. The Password is case sensitive and unique to you and the

manuscript (Figure 4.3).

Login
User 10 [1011
Manuscript 0 [1001
Pazzword |Arteria]B]ood

Figure 4.3
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Pressing on the Accept button opens afile dialog requesting a location to
store the Downloaded Files (Figure 4.4). These are the original files that
the Author attached to the manuscript object. The dafault name for the

folder isDownload with the current date appended.

= work
&
Desktop
=
Save files where?
Download - 07/30/96 |
Figure 4.4

Pressing on the Save button begins the retrieval process. If the network
configuration is incorrect, or if there is any problem in using the network

or accessing the server, an error message appears (Figure 4.5).

Errar inopening remote connection to
A IErver.

Figure4.5

The retrieval process cannot be interrupted once it begins. The progress
bar and progress message is in use on the document window for this
manuscript. Depending on the type of connection you have to the Internet,
the size of the files, and the activity at the SMART server, retrieval can
take anywhere from seconds to minutes. The progress field shows the
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amount of data remaining to be received, especially the size of thefiles.

Tip: If the document window is behind the manuscript window, you won't
be able to see the messages. Move the document window to expose the

progress bar and message field.

If there is any error by the server, or a network interruption after the
transmission has started, an error message appears (Figure 4.6).

j Errorin retrieving manuscripts.

Figure 4.6

If this happens, try again later. If it continues, please contact Technical

Support.

When the manuscript object has been successfully retrieved from the server,
the document window updates to reflect that this manuscript has been
retrieved (Figure 4.7).
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My Reviews = J=

REVIEWER

SMART - System for Manuscript Authoring and Beviewy Technology
Elsevier Scientific ML, The Metherlands

Copyright ® 1996, All Rights Pesetved

H ¥
e
= = = E,
ELSEVIER| | B || & =
) SCIENCE| | & Dpen Delete Check Print
UniqueID _
anuscripts
Title Authors Journal Rewview |G
1001 The cytoarchitectonics o... | Doe,John,E., Edwards, Th... | BRAIN RESEARCH IN... Mot Sent
Review Status
%
1 tessages: &

Figure 4.7

The manuscript shows the ID in the ID column, and the Review column
shows Not Sent. A manuscript window opens for this manuscript
(Figure 4.8).

EE

EE
Ti t| € Lite

The cytoarchitectonics of the Nucleus Ambiguus in the rat
Corresponding Author
Notlfl Catl on M ethOd Authors orresponding Author
Lazt First Middle | Institute |-G Doe Habin E.

The cytoarchitectonics of the Nucleus Ambiguus in the rat

Format of this manuscript R |
Edwards Thomas &, Research In...
Authors White Robert G. Medical Coll... Format W | Research Report |

‘Journal for th! S mar]ug:r! p‘ Journal W I BRAIN RESEARCH INTERACT IVE |
Therne for thl S Manuscri p‘ T [ Theme wr I Spinal cord and brainstern : anatomy |

Institute

These buttons will ddress: Phone: EMan:
dl SF)' ay more I nf Ormml Or _| @ Manuzcript O Abstract O Body O Legends O References O Keywords O Reviem
on the window

Window control buttons — =
Figure 4.8

O Cornrnentary

Window Control Buttons- The buttons at the bottom control the window.

» Cancel closes the window without saving the changes.
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» Send Review sends the review to the server when the review is
complete and ready to send. This button is enabled only when
the review is complete.
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Reading the Manuscript

SMART is software to accelerate and facilitate your part in the review
cycle, by transmitting and receiving your review electronically. Thissection
describes how to retrieve and access each part of the manuscript you have
been asked to review. The buttons at the bottom of the manuscript window

displays information on each part of the manuscript.

* Manuscript - displays the current window containing the most
immediate information about this manuscript, such as the title,
the Authors, the Corresponding Author, thejournal, and theformat.
All of thisinformation must be entered by the Author.

» Abstract - displays the abstract which may have been be entered.
This is optionally entered by the author since the abstract is
generaly in one of the files attached to this manuscript.

* Body - displays the body of the manuscript which may have been
entered. Thisis optionally entered by the author since the body
is generally in one of the files attached to this manuscript.

* L egends- displays the legends of figuresin the manuscript which
may have been entered. This is optionally entered by the author
since the legends are generally in one of the files attached to this

manuscript.

» References - displays the references in the manuscript which
may have been entered. This is optionally entered by the author
since the references are generally in one of the files attached to

this manuscript.
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» Keywords - displays the keywords in the manuscript. This is
required. The keywords used in SMART are standardized for the
supported journals.

* Review - displays your review for the manuscript. This button is
displayed only if the editor is actually requesting areview. This
isrequired if visible

» Commentary - displays your commentary for the manuscript.
This button is displayed only if the editor is actually requesting a
commentary. Thisisrequired if visible

Alert: Only the Manuscript and Keywords information are required
information and will have been entered by the Author and validated by the
editorial office. The only additional information that you as Reviewer can
enter isthe Review or Commentary of the manuscript.
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Writing the Review

Thereview for themanuscriptisentered directly into the manuscri pt window.
Press the Review button on the document window to display the review
information. Selections need to be made on the Acceptability, the Format,
and the Priority of the manuscipt. The referee comments should be
entered. Theconfidential commentsto the Editor are optional (Figure 4.9).

EE

The cytoarchitectonics of the Nucleus Ambiguus in the rat

EE E
Inztructions : Enter in the rewiew here. Tupe it or cut and paste in comments from another docurnent. |
h Sel ec_:ft thE Acceptability w | |
choicestrom ,m |
these popug BT |
menus Cenfidential Comments
it
Confidential
comments are =
ODtI Onal Referee Comments
[
Referee
comments [=
are rm“' rec O Manuscript O Abstract O Endy O Leqends O References O Keywords @ Rewview
O Cornmentary
G

Figure 4.9

Press and hold on the Acceptability button to display a popup menu
(Figure 4.10). Choose the appropriate selection.
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EO==— The cytoarchitectonics of the Nucleus Ambiguus in the rat EE
Instructions : Enter in the review here. Type it or cut and paste in cornments from another docurent. |
- #eceptable in present form |
Enter the acceptability .
N . #eceptable but needs minor revision |
WI th thl S popup mer]U Acceptable but needs major revision |
ol Reiected
[
=
Referee Comments
[
=
O Manuscript O Abztract O Body O Legends O References O Keywords @ Review
o Commentary
G )
) A E

Figure 4.10

Pressand hold onthe For mat buttonto display apopup menu (Figure 4.11).
Choose the appropriate selection.

[I=— The cytoarchitectonics of the Nucleus Ambiguus in the rat =——H1=

Inztructions: Enter in the review hete. Tupe it or cut and paste in comments from another document.

Acceptability W I Acceptable in present form

Enter the formm Wi tl" Present form satisfactory
. Thiz short communication should be a research report
thl S popup mer]L This rezearch report should be a short communication
Confidential Cammnents
il
i
Referee Corments
ks
i

o Manuscript O Abstract o Body o Legends o References O Keywords @ Rewiew

o Cornmentary

Core I

Figure4.11

Pressand hold onthePriority button to display apopup menu (Figure 4.12).
Choose the appropriate selection.
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The cytoarchitectonics of the Nucleus Ambiguus in the rat EE
Instructions : Enter in the review here. Type it or cut and paste in cornments from another docurent. |
#dcceptability W I #eceptable in present form |
Format - I Present form satisfactory |
Enter the priority witk High |
h_ : [‘10derate
H 0w
this popup ment =
=
Referee Comments
[
=
O Manuscript O Abztract O Body O Legends O References O Keywords @ Review
o Commentary
o

Figure 4.12

Complete the review by entering in theconfidential and r efer ee comments
(Figure 4.13). Only the referee comments are conveyed to the Author.

The cytoarchitectonics of the Nucleus Ambiguus in the rat

=0
Instructions : Enter in the review here. Tupe it or cut and paste in cornments from another docurnent.
Acceptability w I Acceptable in present form
Farrat - I Prezent form satisfactory
Priority il I High

Confidential Comments

None ﬁ
%

Referee Comments
This iz a well written report on... ﬁ
K%

O Manuscript O Abstract O Body O Legends O References O Eeywords @ Rewiew

O Cornrmentary

G )

Figure 4.13
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To determine what still needs to be completed for the review, select Check
Review Completeness from the Manuscripts Menu (Figure 4.14). The
keyboard equivalent of Command-K can also beentered from the keyboard.

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

Update this manuscript to document

send Review
Check Review Completeness #K

Figure4.14

A dialog indicates what items require your attention, or if the manuscript
review is ready to be sent Figure 4.15.

Error. You need to enter in referee
A comments.

Figure 4.15

Writing the Commentary

The commentary for the manuscript is entered directly into the manuscript
window. Press the Commentary button on the document window to
display the field in which to enter your commentary (Figure 4.16).
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En] The cytoarchitectonics of the Nucleus Ambiguus in the rat FE
Enter in the commentary here. |
Cornrentary

[
i
O Manuscript O Abstract O Body O Leqends O References O Keywords O Rewiew
@ Cornrmentary
[

Figure 4.16

This completes the Review/Commentary section. Refer to the section on
Sending the Review/Commentary to send the review/commentary to the

SMART server.
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Opening a Manuscript

=

Open

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

Manuscripts saved to the document may be reopened for browsing or for

additional editing of any unsent reviews.

Press on the Open button after selecting a manuscript in the document
window. You can aso select Open Manuscript in the Manuscripts
Menu. This menu item is enabled only when a manuscript is selected. Or
you can double-click on the selected manuscript in the document window.
A manuscript window with this manucript object opens. Browse or edit
the manuscript review if this review has not yet been sent. If the review
has already been sent, the information can only be browsed.
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Deleting a Manuscript

Lelete

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

Manuscripts saved to the document may be deleted if its review has not
been sent to the database.

Press on the Delete button after selecting a manuscript in the document
window. You can also select Delete Manuscript in the Manuscripts
Menu. This menu item is enabled only when a manuscript is selected.
Y ou can also press the Delete key on the keyboard. A confirmation dialog
appearstwice Figure 4.17.

Delete this manuscript entry titled
<The cytoarchitectonics of the Mucleus Ambiguus in the
rat:?

Delete | Cancel |

Confirm - Delete entire manuscript entry?

Delete | Cancel |

Figure 4.17

This action can be undone by selecting Undo Delete Manuscript in the
Edit Menu (Figure 4.18). The manuscript is listed again in the document

window.

Undo Delete Manuscript 382

Cut #H
Copy ®C
Paste #U
Clear e
Select All #®A

Text Tool

Figure 4.18
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The undo of the deletion itself can aso be undone, known as an redo.
Select Redo Delete Manuscript in the Edit Menu (Figure4.19). The

manuscript is again deleted from the document.

Redo Delete Manuscript 32

Cut
Copy
Paste
Clear
Select All

Text Tool

®H
L
U
xZ
A

Figure 4.19
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Printing a Manuscript

&)

Print

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

A manuscript can be printed at any time, whether the review has been sent
or not. Press on the Print button after selecting a manuscript in the
document window. You can aso select Print Manuscript in the
ManuscriptsMenu. This menu item is enabled only when a manuscript
is selected. If aprinter is selected, a summary of the manuscript object is
printed. This function does not print the contents of the attached files. It
only prints the information that is entered with SMART. Figure4.20
shows an example of a print report.

ID: 1001
Created: Tue 07/30/1996 10:50:43 AM (GMT)
Last Updated: Tue 07/30/1996 10:57:19 AM (GMT)

Title: The cytoarchitectonics of the Nucleus Ambiguus in the rat
Authors: Doe,John,E.

Corresponding Author: Edwards, Thomas, A., White, Robert G.
Journal:
Theme: Spinal cord and brainstem: anatomy
Notification: EMail

Paper Format: Research Articles

Keywords: Cytoarchitecture, Brainstem, Circuit
Abstract: None

Body: None

Figure legends: None

References: None

Review Date: Tue 07/30/1996 10:57:19 AM (GMT)
Acceptable: Acceptable in present form

Format: Present form satisfactory

Priority: High

Referee Comments: This is a well written report on...
Confidential Comments: None

BRAIN RESEARCH INTERACTIVE

Figure 4.20
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Sending the Review/Commentary

The manuscript review/commentary is ready to be sent to the SMART
server when the Send Review button is enabled. Y ou can also select Send
Review from the Manuscripts Menu (Figure4.21). This menu item is
enabled only when the review/commentary is ready to be sent.

Retrieve Manuscript
Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

Update this review to document

send Review
Check Review Completeness #K

Figure4.21

A dialog appears requesting the same manuscript ID and password as
when retrieving it (Figure4.22). Enter the same information. If this

information islost, contact the Editor of the journal for a new password.

Login

User I [1011

Password | ArterialBlood

pooept_|

Figure 4.22

After pressing the Accept button, a confirmation dialog appears asking to
save all of the data to the disk (Figure 4.23).
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&11 data must be saved to disk before sending review.
Save now'?

Figure 4.23

Pressing the OK button saves the data and to continues the
review/commentary sending process. A final confirmation window appears
summarizing the manuscript. Confirm that this is the correct manuscript
review/commentary to send (Figure 4.24).

Verlfy the correct Uerify that this Rewiew/Commentary is
. correct.
review. Once the et s
. . The cytoarchitectonics of the Mucleus Ambiguus in the rat.
review %nd| nc Doe John E., Edwards, Thomnas, A., White Robert G.. BRAIN
b . ~ RESEARCH INTERACT IVE.
proc egl nS’ you If this is the correct manuscript and you are
Cannot |nterrupt |‘| ready to zend this Review/Commentary to the

server, click on SEHD.

Figure 4.24

Pressing on the Send button starts the review/commentary sending process.
If the network configuration is incorrect, or if there is any problem in

using the network or accessing the server, an error message appears.

Errar inopening remote connection to
& SEFYEF.

Figure 4.24

The sending process cannot be interrupt once it begins. The progress bar
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and progr essmessageisin use on the document window for thismanuscript.
Depending on the type of connection you have to the Internet and the
activity at the SMART server, review/commentary sending can take
anywhere from seconds to minutes.

Tip: If the document window is behind the manuscript window, you won't
be able to see the messages. Move the document window to expose the
progress bar and message field.

If there is any error by the server, or a network interruption after the
transmission has started, an error message appears (Figure 4.25).

Error: Server did not stare the review
& properly.

Figure 4.25

If this happens, try again later. If it continues, please contact Technical

Support.

When the manuscript review/commentary is successfully sent to the server,
the following message appears (Figure 4.26).
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j Manuscript review sent successfully.

Figure 4.26

The manuscript review/commentary has been sent to the SMART server
and the manuscript window closes. The document window updates to

reflect that this manuscript review/commentary has been sent (Figure 4.27).

EI=—————————— sMyReviews =————————— -

REVIEWER

STHAPSE - Internet Scientific Manuscript S ubmission and Review
Elsevier Scientific Publishers
Copyright ® 1996, All Rights Reserved

ELSEVIER = [ = |15
SCIENCE h%e Uépen De

anuscripts
[1o] Title Authors Journal Fewiew H}
2 The cytoarchitectonics o... i Doe,Jdohn E. BR AIM RESEARCH O7 /30796 17 :29
Review Senc
Date/Time
i
] Messages: =
Figure4.27

The manuscript now shows the ID in the ID column, and the Review
column shows the Review Send date and time. The Send Review button
in the manuscript window for this manuscript is disabled if reopened. The
manuscript review/commentary cannot be resent. Furthermore, the popup
buttons on the review portion of the manuscript window are disabled,
protecting the current selections (Figure 4.28).
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N The cytoarchitectonics of the Nucleus Ambiguus in the rat BE
Instructions : Enter in the review here. Type it or cut and paste in comments from another docurnent. |
1 Acceptability W I Acceptable in present form |
When a manug:n pt h&  — Format W I Preszent form satizfactory |
been submitted, Loty <] sin |
b 1 1 Confidential Cornments
certain items are disabled e ©
These fields are enabled 2
Referee Comments
m thﬁ you Can CUt a‘nd This iz a well written report on... ﬁ
paste portions of these
reviews to other reviews o
o Manuscript O Abstract o Body O Legends O References O Eeywords @ Review
O Carnnentaty
G

Figure 4.28

= Tip: Even though the review buttons are disabled, the two fields holding
your review text are enabled and selectable with the cursor. Y ou can copy
text, or drag this text to the Finder desktop or other windows to reuse

portions of your review elsewhere.
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Checking a Manuscript

Retrieve Manuscript
0Open Manuscript
Delete Manuscript
Check Manuscript
Print Manuscript

The status of the manuscript you are reviewing can be checked by using

the Check button on the document window.

Pressing on the Check button after selecting a manuscript in the document
window startsthe checking process. Check M anuscript intheM anuscripts
Menu can also be selected. This menu item is enabled only when a
manuscript is selected. If the network configuration is incorrect, or if

there is any problem in using the network or accessing the server, an error
message appears.

Error inopening remote connection to
A SEFVEr.

Figure 4.28

The checking process cannot be interrupted once it begins. The progress
bar and progress message is in use on the document window for this
manuscript. If there is any error by the server, or a network interruption
after the checking has started, an error message appears (Figure 4.29).

j Errar in checking ranuscript.

Figure 4.29
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I this happens, try again later. If it continues, please contact Technical
Support.

When the manuscript has been successfully checked by the server, amessage
window appears with the status. There is one general message if the
manuscript is anywhere in the review process (Figure 4.30). The extent of
the message, if any, is determined by the editors.

t Manuscript is under review

Figure 4.30

Manuscript isunder review meansthat the manuscript has been submitted,
and isin the review process. The specific phase of the review process is
not reported.

Other messages appear once the review process has comcluded for

Acceptance, Regection, and Revision.
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Appendix A - Certified Software Applications

SMART is not anauthoring program. This means that the Author creates
the content of the manuscript with other programs, and use SMART to
bind them together into a manuscript object that is then transmitted over
the Internet to the SMART system. Since the Reviewers and Editors of
SMART require that they be able to open and view your files, certified
software applications are below. The Author should make every effort to
use one of more of these applications when authoring the manuscript. |If
this is not possible, the Author should comment heavily on the name and
version of the program, the computer, and the version of the operating
system in the Comments field of each file, or put this information in the
Comments section of the manuscript object.

Word Processors (Macintosh)

» Microsoft Word 3.0, 4.0, 5.0, 6.0
» WordPerfect 3.0

» PageMaker 5.0

* NisusWriter 4.0

Spreadsheets. (Macintosh)

* Excel 5.0

Graphics (Macintosh)
* MacDraw I

» Canvas
* Photoshop
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e |lustrator
* Freechand
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Appendix B - Optimizing Memory

The documents are RAM based. Virtua memory, either Apple's virtual
memory or Connectix’s RAM Doubler, can be used with this application.
However, neither is recommended. Apple’ s virtual memory mechanism s
very inefficient. RAM Doubler works better but it too can cause noticeable
delays when physical free RAM islow. Be sure that 32 bit addressing is
on for the older Macintoshes, and that the Modern Memory Manager for
PowerPCsison.

To turn off virtual memory (Figure B1):

1. ChooseControl Panels from the Apple menu, then double-click
Memory.

2. Press on the Off button to turn off virtual memory.

3. ChooseRestart from the Special menu.

EDVV———— Memory E[
E Disk Cache Cache Size 307K
=z Always On
Modern Mermory Manager
o
— ) oFf
Select Hard Disk :
Wirtual Memmory Lo Havd Drige hd
O on ) AvtailaFﬂe on disk: &M
= @ off #vailable built-in mernory @ 20
Percent of available rernory
G RAM Disk . to uze for a RAM disk:
#| on
o
® off
R M Disk Size
Use Defaults
w753

Figure B1
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Y ou should read the Appendix on Optimizing Memory to set the memory
parameters for this application to the proper levels.
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Appendix C - Networking I ssues
This application uses the Internet and the TCP/IP protocol to communicate
with the SMART server. The Macintosh computer must be capable of
accessing the Internet, and must be able to run TCP/IP. On the Macintosh,

TCP/IPis provided by using either MacTCP or Open Transport.

* The minimum version of MacTCP is 2.0.6
» The minimum version of Open Transportis1.1

Apple' s AppleTalk Remote Access (ARA) can also be used with either of
the two IP enabling programs above to provide network access, but the

transmission speeds are limited to the speed of the phone modem used to
make the ARA connection.

IP Address and Port number must be configured. See the chapter on

The Basics to see how to do this. The addresses and port number are:

Current IP Address of SMART Server (asof Jan 1, 1997):

* 192.26.252.151

Current Port Number of SMART Server (asof Jan 1, 1997):

* 7000
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Appendix D - Useful Commercial Software

Connectix’s Speed Doubler should be used on every PowerMacintosh
because it replaces Apple’'s Motorol 680x0 emulator with a much better
one. This application was written in QKS SmalltalkAgents, and only
portions of it arein native PowerPC code. With Speed Doubler, throughput
probably increases (as well as in many other commercial software
applications) by at least two-fold.
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Appendix E - Themes

The abbreviated list of themes is from the Society for NeuroSciences
themes.

THEME A: DEVELOPMENT AND REGENERATION
Developmental genetics
Genesis of neuronsand glia
Cell lineage and determination
Cell differentiation and migration
Pattern formation, compartments, and boundaries
Process outgrowth, growth cones, and sprouting
Axon guidance mechanisms and pathways
Formation and specificity of synapses
Neurotransmitter systems and channels
Neurotrophic factors: expression and regulation
Neurotrophic factors: biological effects
Neurotrophic factors: receptors and cellular mechanisms
Hormones and development
Nutritional and prenatal factors
Neuronal death
Gliaand other non-neuronal cells
Motor systems
Sensory systems
Cerebral cortex and limbic system
Visual system
Regeneration
Transplantation
Aging process

THEME B: CELLULAR AND MOLECULAR BIOLOGY
Staining, tracing, and imaging techniques
Neurogliaand myelin
Membrane composition and cell-surface macromolecules
Cytoskeleton transport and membrane targeting
Blood-brain barrier
Gene structure and function: general

THEME C: EXCITABLE MEMBRANES AND SYNAPTIC TRANSMISSION
Presynaptic mechanisms
Mechanisms of neurotransmitter release
Postsynaptic mechanisms
L ong-term potentiation: physiology
L ong-term potentiation: pharmacology
Ligand-gated ion channels
Sodium channels
Calcium channel structure, function, and expression
Calcium channel physiology, pharmacology, and modulation
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Potassium channel structure, function, and expression
Potassium channel physiology, pharmacology, and modulation
Other ion channels

THEME D: NEUROTRANSMITTERS, MODULATORS, TRANSPORTERS,
AND RECEPTORS
Acetylcholine
Acetylcholine receptors: muscarinic
Acetylcholine receptors: nicotinic
Excitatory amino acids: excitotoxicity
Excitatory amino acids: anatomy and physiology
Excitatory amino acids: pharmacology
Excitatory amino acid receptors: structure, function and expression
Excitatory amino acid receptors. physiology, pharmacol ogy and modulation
GABA receptors
GABA
Peptide receptor structure and function
Peptides: biosynthesis, metabolism, and biochemical characterization
Peptides: anatomy and physiology
Opioid receptors
Opioids: anatomy, physiology, and behaviour
Catecholamine receptors
Catecholamines
Serotonin receptors
Serotonin
Other neurotransmitters
Transmittersin invertebrates
Interactions between neurotransmitters
Uptake and transporters
Regional localization of receptors and transmitters
Second messengers and phosphorylation
Signal transduction: gene expression
Behavioural pharmacol ogy
Receptor modulation, up- and down-regulation

THEME E: ENDOCRINE AND AUTONOMIC REGULATION
Hypothal amic-pituitary-adrenal regulation
Hypothal amic-pituitary-gonadal regulation
Osmotic and thermal regulation
Neuroendocrine regulation: other
Neural-immune interactions
Cardiovascular regulation
Gastrointestinal and urogenital regulation
Respiratory regulation

THEME F. SENSORY SYSTEMS
Somatic and visceral afferents
Spinal cord
Subcortical somatosensory pathways
Somatosensory cortex and thalamocortical relationships
Pain: pathways
Pain modulation: anatomy and physiology
Pain modulation: pharmacology
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Retina and photoreceptors
Subcortical visua pathways

Visual cortex: striate

Visual cortex: extrastriate

Visua psychophysics and behaviour
Auditory, vestibular, and lateral line: periphery
Auditory systems: central physiology
Auditory systems: central anatomy
Olfactory senses

Gustatory senses

Invertebrate sensory systems

THEME G: MOTOR SYSTEMS AND SENSORIMOTOR INTEGRATION
Cortex
Basal ganglia
Thalamus
Cerebellum
Vestibular system
Oculomotor systems
Reflex function
Spinal cord and brainstem
Control of posture and movement
Circuitry and pattern generation
Invertebrate motor function
Muscle

THEME H: OTHER SYSTEMS OF THE CNS
Limbic system and hypothalamus
Association cortex and thalamocortical relations
Comparative neuroanatomy
Brain metabolism and blood flow

THEME |I: NEURAL BASIS OF BEHAVIOUR
Cognition
Learning and memory;: systems and functions
Learning and memory: physiology
Learning and memory: pharmacology
Neural plasticity
Motivation and emotion
Biological rhythms and sleep
Neuroethol ogy
Invertebrate learning and behaviour
Ingestive behaviours
Stress
Hormonal control of reproductive behaviour
Monoamines and behaviour
Neuropeptides and behaviour
Drugs of abuse: alcohol, barbiturates, and benzodiazepines
Drugs of abuse: amphetamine and other stimulants
Drugs of abuse: cocaine
Drugs of abuse: opioids and others
Psychopharmacol ogical agents
Aging
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THEME J. DISORDERS OF THE NERVOUS SY STEM
Genetic models
Developmental disorders
Epilepsy: human studies and animal models
Epilepsy: basic mechanisms
Epilepsy: anti-convulsant drugs
Degenerative disease: Alzheimer's - beta amyloid
Degenerative disease: Alzheimer's - cognitive function
Degenerative disease: Alzheimer's - neuropharmacology and
neurotransmitters
Degenerative disease: Alzheimer's - miscellaneous
Degenerative disease: Parkinson's
Degenerative disease: other
Ischemia
Trauma
Infectious diseases
Neuromuscular diseases
Neuropsychiatric disorders
Neurotoxicity
Neuro-oncology



